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Design your pages 
Whether you like to work in the new code editor or use the standard view to visually design your pages, 
these tips will help you build your site.  

1. Stretch your site 
Some developers call it liquid; here at CNET we call it stretchy.  It's the quality that lets your Web page 
change as a user resizes the browser window, so that there's no white space when the window is large or 
scrollbars when it's small. Most simple pages are stretchy by nature, but creating stretchy pages is 
difficult when you have multiple columns and tables. You'll typically want to use a mixture of fixed-width 
columns and spacer GIFs to create a design that will work in both Internet Explorer and Netscape 
Navigator. Dreamweaver 4.0 makes designing stretchy pages easy.  

Open your page and switch to Layout view by using the button on the Object palette. You'll see the 
column width and a tiny drop-down arrow at the top of each column. Click the arrow on the column you 
want to make stretchy and choose Make Colum n Autostretch. (Only one column can be set to 
autostretch.) Instead of the number showing the width, you'll now see a wavy line at the top of the 
column. Dreamweaver automatically creates the spacer GIFs, which are denoted by the double bar on 
top of the column and are necessary to make this layout work. (If it's the first time that you're adding a 
spacer GIF to a site, a dialog box will ask if you want to use an existing spacer GIF, let Dreamweaver 
create one, or not use spacer GIFs at all.)  

2. Create a personal color caddy 
The new Assets panel in Dreamweaver 4.0 is a way to organize your files according to type--graphics, 
templates, and so on--within your site. Once you define your site (Site · New Site), all of these types of 
elements are automatically added to the proper tabs in the Assets panel. The panel also has a Color tab 
where it stores all of the colors in your site, including colors for text, backgrounds, and links. It's a site-
specific color palette just for you. To see the palette, open the Assets panel (Window · Assets) and click 
the tiny color wheel on the left. You'll see a list of all the colors within your site. You can drag those colors 
to selected text. Better yet, when you highlight a particular color, its hexadecimal value and its RGB 
number appear. And if you want to narrow your site's color palette further, you can do so by adding only 
certain colors to the Favorites section of the Assets panel. Just highlight the color and click the bottom, 
rightmost button (called Add to Favorites) in the window.  

3. Create a pop-up navigation system 
Creating a pop-up menu navigation system can take a lot of JavaScript coding. But if you have the 
Dreamweaver/Fireworks Studio, you can make quick work of it. Start within Fireworks and select a hot 
spot or slice within your image. Then choose Insert · Pop-Up Menu; in the Set Pop-Up Menu dialog box, 
you can add items to your menu by entering the item name and clicking the Plus button. You can set the 
menu's text and links as well as create submenus and rearrange items. When you're finished, click Next 
to set the preferences such as color, font, and so on. You can choose to show the menu system in HTML 
or as images. Click Finish and you'll see an outline of the menu system when you mouse over the original 
hot spot or slice. When you export the file, Fireworks creates all the HTML, JavaScript, and images 
needed for the file to work in Dreamweaver. There are even more ways that Dreamweaver can integrate 
with other products.  



Integrate with other products 
One of the coolest aspects of Dreamweaver is its integration with other Macromedia products. The 
program offers full-featured, round-trip graphics editing with Fireworks, and now you can create Flash text 
and Flash buttons within Dreamweaver, too.  

4. Animate GIFs 
If you have the Dreamweaver/Fireworks Studio, you'll have an unprecedented level of integration 
between the two products. Even if you're not a graphics designer, you'll probably want to animate a GIF 
occasionally. To animate a graphic that's already in a page, select the graphic while in the standard 
window and click the Edit button in the Property Inspector. The graphic will automatically be loaded into 
Fireworks, which is your default graphics editor if you have the Studio bundle. (If you look closely, you'll 
notice the Editing From Dreamweaver text and images that signal you initiated the editing from 
Dreamweaver.) Now working in Fireworks, select the graphic and choose Modify · Animate · Animate 
Selection. Next, complete the preferences in the Animate dialog box, choosing how many frames the 
animation will have, the direction in which it will move, and so on. You can use the Frames panel to set 
the speed of the animation and the Object panel to change the properties. To export the file, use the 
Optimize panel to select Animated GIF as the file type. Click Done, and Fireworks automatically exports 
the image with the optimization settings, updates the GIF file, and displays the updated file in 
Dreamweaver. Click File · Preview in Browser to check out your nifty animation.  

5. Add a flashy button 
Dreamweaver lets you create and add Flash button objects--without even owning Flash. Version 4.0 
ships with a number of premade Flash button objects that make up different styles of buttons. Select 
Insert · Interactive Images · Flash Button to see the different styles. Within this dialog box, you can 
even mouse over the sample of each style and see how it will animate within a browser. Highlight the 
style you want to use and fill in any other parameters that you'd like, such as the button text, font, color, or 
customized file name. Click OK. The SWF file will be created and inserted into your page.  If you click it, 
you'll see that the Property Inspector displays the file's properties. And if you expand the Property 
Inspector, you can click the Play button to preview the button's action without going to a browser.  

6. Make moving text 
Adding Flash text objects is just as easy as adding Flash buttons to your pages. Again, with 
Dreamweaver 4.0's new capabilities, you don't even have to own Flash. HTML coders who have no 
interactive media experience can create small Flash-based text animations. As Flash can be viewed by 
97 percent of Web surfers (according to Macromedia), this adds interactivity to your pages without 
creating compatibility problems. To begin, choose Insert · Interactive Images · Flash Text. Fill in all the 
preferences, such as the text to animate; the font, color, and size; and so on.  

Customize the interface 
You can customize Dreamweaver to your heart's content. These three tips will help you set up the app to 
suit yourself.  

7. Change keyboard shortcuts 
Dreamweaver has been customizable and extensible for quite some time. For instance, you can change 
menus just by programming or adding your own objects. But you don't have to be a master developer to 
change the keyboard shortcuts, because Dreamweaver ships with a graphical interface called the 
Keyboard Shortcut Editor. Select Edit · Keyboard Shortcuts and wait for the dialog box to load with the 
sets of shortcuts that you can tweak. To alter a shortcut, use the Current Set and Commands drop-down 
lists to find the existing command that you want to change. Highlight the current shortcut, and it appears 
in the Shortcuts field. To add a shortcut, click the Plus button and enter the new keystrokes that you want 
to use, which will be entered in the Press Key field. Click Change. You can also remove a shortcut by 
highlighting it and clicking the Minus button.  



8. Reconfigure the Site window's columns 
By choosing View · File View Columns from within the Site window, you can customize what and how 
columns appear in the Site view. Highlight a column name and use the up or down arrows to rearrange 
where it appears, or deselect the Show field to hide that column altogether. You can even create new 
columns by clicking the Plus button and giving your new column a name. You can also associate your 
column with a Design Note by choosing an existing Note in the drop-down list.  

9. Actually read the Code Reference 
When you launch the O'Reilly Code Reference (Window · Reference) to check on, say, attributes or 
browser compatibility, the default window displays the reference in tiny text. But if you click the tiny right-
arrow button at the upper right corner of the window (just below the Close button), you'll see a drop-down 
list where you can choose from Small Font (the default), Medium Font, or Large Font. Choosing a larger 
font makes the code reference that much more helpful: now you don't need a magnifying glass to read it!  

Extend Dreamweaver 
The Macromedia Exchange for Dreamweaver has seen more than 1 million downloads since its debut in 
April 2000. Extensions, developed and exchanged by Dreamweaver users, let you add functionality to the 
program, and they're usually offered for free. All you have to do is register with the site to download them. 
We've picked three of our favorite extensions.  

10. Add fiery buttons 
Tip 5 showed you how to add Flash buttons to Dreamweaver, which ships with 20 premade button styles. 
You can also add Fireworks buttons , and an extension will help you do it quickly. Go to the Exchange for 
Dreamweaver, search for "InstaGraphics Extensions for Dreamweaver," and download the 577K file for 
your system. To install it, switch to Dreamweaver and select Commands · Manage Extensions, then 
choose File · Install Extension. Once you restart Dreamweaver, you can add Fireworks buttons with six 
funky styles, from Surfboard to Bulletbar, by using the Insert · Interactive Images · Fireworks Button 
command. You can also use Commands · Convert Bullets To Images and Commands · Convert Text 
To Images, both of which will automatically run Fireworks for you.  

11. You're my favorite! 
You'll find the Add To Favorites  extension by searching the Exchange. The tiny 3K file downloads quickly, 
and you use the same steps to reach the Extension Manager (Commands · Manage Extensions, then 
File · Install Extension). Once you restart Dreamweaver, this extension adds a behavior to the program. 
If you add this behavior to a page, it lets users easily add your page to their browser's Favorites menu. 
You can also speci fy how the shortcut will appear in the user's browser. If you set an exact title, an icon 
will appear if you use the shortcut icon object. (This extension works for users of Internet Explorer 4.0 and 
later.) To use the extension, just choose the Behaviors palette from the Window menu and look under the 
Internet Explorer drop-drown menu.  

12. Prefab forms 
Why spend time coding forms when someone has already done the work for you? Download the Form 
Builder extension at the Exchange and you can instantly populate form fields for country codes, gender, 
marital status, age group, and other categories. Download the 11K file from the Exchange, then install it 
through the Extension Manager (Commands · Manage Extensions, then File · Install Extension). Once 
you restart Dreamweaver, you'll find the extension at Insert · FormBuilder. A dialog box will show all of 
your ready-made options for creating your form.  

Dreamweaver Tips and Tutorials 
http://webdesign.about.com/cs/dreamweavertips/index.htm 
 
Tips and tutorials to help you get the most out of Macromedia Dreamweaver.  



Dreamweaver Extensions 
Free objects, behaviors, and commands for Macromedia Dreamweaver.  

12 tips for Dreamweaver 4.0 
Get the most from Dreamweaver 4.0's new features with tips on designing pages, 
customizing the interface, and more.  

Dreamweaver2 QuickTime Tips 
Wonderful help for beginners. These QuickTime movies from Lynda Weinman cover frame 
targets and background images, the Properties Inspector, timeline animation, site 
management, setting background color, JavaScript rollovers, creating framesets, animated 
rollovers, and selecting individual table cells.  

Dreamweaver Tips 
Tag tips, graphics tips, layout tips, site tips, and tips for working smart. Excellent 
information from Builder.com.  

Dreamweaver News & Information 
The latest DW news, release notes, bug reports, and an international FAQ. From Craig 
Foster.  

Dreamweaver Walk-Through - Lesson 1 
Covers basic HTML, forms and images, and tables. From WebMonkey.  

Dreamweaver Walk-Through - Lesson 2 
Covers DIVs and layers, stylesheets, javascript, timelines, and customizing. From 
WebMonkey.  

Extending Dreamweaver-Macromedia 
Write your own objects, behavior actions, and commands that affect Dreamweaver 
documents and the elements within them. From Macromedia.  

Extending Dreamweaver - Webmonkey 
Learn how to customize Dreamweaver to do almost anything, from automating repetitive 
tasks to customizing the interface. From Webmonkey.  

International Dreamweaver FAQ 
32 answers to frequently-asked questions regarding the use of Dreamweaver. English, 

Dutch, French, German, Russian, Spanish, and Swedish versions are available.  

Dreamweaver Walk-Through 
Lesson 1 
by Taylor 
If you've been a professional Web developer for any length of time, you have probably used 
a WYSIWYG editor at some point or another. Either the repetitive and constant task of 
inserting bold tags by hand numbed your brain, or you thought there just has to be an 
easier way to manage that 50-column table. Or, worst of all, some higher-ups - who don't 
know their <font> tag from their <frameset> - decreed that "editor X" would make the 
staff 50 percent more productive. So, for whatever reason, you've put a WYSIWYG editor to 



the test. And, like many a webmonkey, you ran screaming back to your trusty, rusty old 
text editor. Because, at the end of the day, it was faster.  

Who wants to spend grueling hours cleaning up after the stupid robot, removing all its 
incomprehensibly bad HTML? At least, with ye olde text editor, your files were nice and 
clean, and people could actually understand them as they passed down the production 
chain. Pages were smaller, rendered faster, and were generated more quickly when you left 
the HTML up to your brain.  

But I don't want my brain to be an HTML renderer - that's a job for my computer. I want my 
brain to concentrate on being a great artist, a brilliant writer, or a Zen hacker. And 
maintaining an inside-and-out knowledge of HTML tags is a means really, not an end.  

Enter Macromedia's Dreamweaver (Webmonkey's review of Dreamweaver 4 will give you 
the specifics of the latest release). It recognizes human strengths and computer 
weaknesses: HTML is wacky enough to need a human hand to massage it into place, but 
people don't want to mark up content all day - they want to concentrate on the operation of 
Web sites on a higher, more creative level. Dreamweaver does a good job of generating 
HTML code, but at no time tries to convince you that it knows best or that it's the best tool 
for all jobs. It's happy to pass off your page, or portion thereof, to a more adept application 
and then continue on where it left off. Dreamweaver also realizes that it doesn't know all 
the tricks, so it allows you to extend the editor using the languages that you are used to: 
HTML and JavaScript.  

However, the fact that it works well in the toolset of a professional comes at a cost: 
Dreamweaver won't protect you from yourself. If you don't know what you're doing, it's 
easy to make a mess of things.  

This tutorial will help step you through Dreamweaver with confidence. I'll show you how to 
make it do the work for you. At the same time, you'll still be able to produce a final product 
that doesn't need some angry production type to clean up after it (and then belittle you for 
using a WYSIWYG tool), which can really suck since that production type is probably you.  

The first step in this tutorial involves get yourself a copy of Dreamweaver. If you already 
have the most recent version on your machine, then you're in business (but if you have 
version 1.0, upgrade to version 1.2 now, since we'll be covering features specific to version 
1.2). The other alternative is to download a fully functional evaluation copy from 
Macromedia.  

Since Dreamweaver comes with a fairly comprehensive help system that covers a lot of the 
minutiae of Dreamweaver, I'll focus on problems that may not be intuitively obvious, such 
as how to generate a page using CSS for all the style information, or making a dHTML 
animation. So the first lesson of the tutorial: liberally press that F1 key and explore the help 
system, or look for this symbol on windows which will send you directly to the help file for 
that palette.  

Now lets make some standard HTML pages.  

The first thing to look for when you start up 
Dreamweaver is the three default palettes: the 
Objects palette, the Properties palette, and the 



Launcher palette. From here you can either control 
the content on your page or launch other palettes 
that can further modify your page. Now let's use 
these three tools to construct a simple Web page.  

To get something we can play around with, start by 
typing in some dummy text.  

The quick wary Shvatz jumps over 
the lazy Thau.  

Now look at the Properties palette. Here you will 
find all sorts of ways to modify your HTML text.  

 

Let the games begin: Go crazy and make the text 
unreadable like some ransom note (i.e., pretend it's 
1984 and we've just opened up MacWrite for the 
first time).  

The quick wary  Shvatz jumps over 

the lazy Thau.  

Do this by highlighting or double-clicking a word 
and then adjusting the relevant property.  

Bold and italics:  
<b></b> <i></i>  

Fonts:  
<font face="foo"></font>  

Size:  
<font size="#"></font>  

Color:  
<font color="#RRGGBB"></font>  

Link:  
<a href="foo.html></a>  



   

<font color="#66FF00">The</font>  
<a href="http://www.webmonkey.com/"> quick</a>  
<font face="Georgia, Times New Roman, Times, serif">wary</font> 
<b>Shvatz</b>  
<i>jumps</i>  
<font color="#FF0000">over</font>  
<font face="Arial, Helvetica, sans-serif">the</font>  
<font size="5">lazy</font>  
Thau.  

As you can see, most tags concerning the look of 
your text are located in the Properties palette. You 
can also modify a block of text from the Properties 
palette: the alignment of the paragraph, style of 
list, blockquote, and headings.  

• The quick wary Shvatz jumps over the lazy Thau. 

Alignment: <p|div align="left|center|right"></p|div>  

Lists: <ul><li></li></ul> <ol><li></li></ol>  

Indentation: <blockquote></blockquote>  

Format: <h#></h#> <pre></pre>  

<blockquote>  
<ul> 
<li> 
<div align="right"> 
<pre>The quick wary Shvatz jumps over the lazy Thau.</pre> 
</div> 
</li> 
</ul> 
</blockquote>  

Each of the functions directly corresponds to a tag 
or group of tags. So as you insert the tags, you 
insert raw HTML tags that behave in Dreamweaver 
as they behave in your browser. This is very 
important since, with one or two exceptions, you 
don't have to keep track of any special tags or 
comments. DW just puts HTML on your page, 
rendering the HTML as you see it. Truly, what you 
see is what you get. To prove this, take a look at 
the Launcher palette. 

 
The Launcher palette controls the task-specific 



palettes, the Site, Library, Styles, Behavior, Time 
Line, and HTML palettes. You will notice that the 
same icons you find in the Launcher are also at the 
bottom of the document window, in the second 
divider of the Windows menu, and bound to keys F5 
to F10. In other words, it's quite redundant. 
Anyway, open the HTML palette.  

Press or F10 to get:  

 
This is the source of your HTML page. If you keep it 
open while you work in Dreamweaver, you can see 
the HTML dropping in as you type. Try typing in 
some text with HTML coding into this window, then 
click back to the main document palette.  

Just as you typed it right? Unless you made a 
mistake, in which case you'll probably get 
something like this: This does not mean 
that you have a tag that Dreamweaver can't 
interpret (those are usually just not rendered). 
<mistake></mistake> is valid and won't be flagged as 
an error in Dreamweaver, but a closing tag without 
an opening tag will be flagged with the yellow error 
color and appear in the document window.  

You may notice that the HTML window lacks any 
kind of super-duper multi-file, grep, regex, 
scriptable, macro , bindable key thingies that you 
come to expect and rely on in an HTML editing 
program. That's because Dreamweaver is designed 
to fit in with your existing toolset, and not replace 
it. Click on the button to launch the 
preferences where you'll be asked to define an 
external editor. Type in or browse to the location of 
your favorite editor to send your page there, where 
you can edit and use all the techniques that you're 
used to. The commercial version of Dreamweaver 
comes with Homesite for the PC and BBEdit for the 



Mac, but should work with most programs (I've 
even gotten mine to work with emacs for 
Windows). Return to Dreamweaver and your page 
will refresh, and any changes you have made in the 
other editor will be on the page.  

But unless you're really into old -school Net 
aesthetics, you'll probably want your page to have 
something more than blocks of text styled with 
various HTML tags. You'll want images, applets, 
forms, plug-ins, scripts, and all the other elements 
that made HTML so gosh darn popular. That's 
where that long vertical Objects palette comes into 
play. From there you can insert other HTML objects. 

Forms and Images 

The most common form of object is an image, and 
you can insert one by clicking on the icon in the 
Object palette. Click on it to invoke a pop-up 
window that asks for the URL of the image you wish 
to embed, which you can either type in or browse 
to on your file system. Once you insert an image, 
say a little smiley, you will see it on the page with 
an outline around it and three black boxes.  

 

You can grab any of the three "grippers" on the 
image and change the size of the ima ge. The 
gripper on the right changes just the width, the 
gripper on the bottom changes just the height, 
while the one in the bottom right corner can change 
both. Try stretching the image all out of proportion. 
As you do so, notice that the UI for the Properties 
palette has completely changed. The controls for 
tags that modify the text have been replaced with a 
new set of controls designed to allow you to edit 
the Image tag. 

 

Type some new number values in the W or H field 
in the image and the dimensions of the image will 
change. Click on the label of these two fields to 
return the image to its original size. You can also 
add or modify most every attribute of an Image tag 



from here. The astute HTML jockey, however, will 
notice that quite a few Image tag attributes aren't 
represented on the palette, such as the border. To 
access the additional attributes, click on the 
button at the lower right of the palette.  

 

Now you have full access to the Image tag and all 
it's attributes, plus a few other functions like the 
Image map editor and an Edit Image button (which 
works kind of like the External Editor button in the 
HTML window). Play around with all the fields and 
then check the Image tag in your HTML editor. 
Again you'll notice that you're just making changes 
to the various HTML tags. Dreamweaver is just an 
easy-to-use interface that generates the same old 
HTML - nothing too exciting going on.  

Insert some Shockwave , Flash , or an ActiveX 
control , and watch how the interface changes 
depending on the context. Dreamweaver is all 
about contextual menus. The area you select on the 
page will determine what the Properties palette will 
show, and what menu you get when you right -click 
on a PC or option-click on a Mac.  

Of course not every thing is available in the Objects 
menu initially. Mostly you'll find structural (divs 
and tables ) and replaced elements (images 
and plug-ins and applets ) as you start out. But 
as any HTML neophyte knows, there's a lot more to 
it than that. The Insert menu appears to represent 

the Objects menu, except that it 
goes on to list lots of other tags 
that don't appear to be listed on 
the palette: Forms, Scripts, Line 
breaks, and other such tags. 
Remember that Dreamweaver does 
everything contextually, and the 
Objects palette is no exception.  

Click on the arrow in the upper left of the palette to 
access any of the groups of insertable objects in 
Dreamweaver. By default these categories are 
Common, Forms, and Invisibles. So far we've been 



working with elements in the common grouping. 
Now let's work with the Forms group. You should 
get a listing of the form elements 

Form tag: <form></form>  

Text input: <input type="text">  

Button: . <input type="submit">  

Checkbox: <input type="checkbox">  

Radio button: <input type="radio">  

Select menu: <select name="select"><option></option></select>  

File upload: <input type="file">  

Image button: <input type="image">  

Hidden Form field: <input type="hidden">  

When you construct a Form make sure that the 
Form elements exist within a form tag , 
otherwise they won't work (same goes when you 
edit the HTML by hand). Dreamweaver gives you 
the absolute freedom to mangle a Form (or any 
type of HTML really). Remember: You're the boss. 
Note: If you can't see the Form Bounding Box it 
might be because you have your View Invisibles 
option turned off. If so go to the View menu and 
select it.  

The View Invisibles option will also toggle on the 
visibility of aligned images, positioned elements, 
hidden form fields, and all the elements in the 
Invisibles collection: anchor , comment , script 

, and linebreak (which is also available by 
hitting Shift-Return).  

One important tag that you won't find as an icon or 
a menu item is the <BODY> tag. Look in the Modify 

menu and select Page Properties, which will be the 
first item available. This allows you to modify the 
Body tag, setting things such as the text and link 
colors, the background, and also the Title tag for 
your page.  



Although it's nice to be able to see your forms as 
you create them, the benefits of this WYSIWYG 
really only become clear when tackling the one 
main headache that every Web designer has to 
confront: tables.  

Put WYSIWYG on your Tables 

Just so there is no confusion on the matter, this is 
what your average Web designer sounds like after 
an all-night table debugging session.  

AAAAAAAAAAAAHHHHHHHHHHHHHHHHHHHHRRRRRRGGGGGGGGG!!!!!!!  

Now that that's out of my system, let's look at the 
table features of Dreamweaver, which just may cut 
out a few A's and H's from that primordial scream.  

A lot of Web design frustration stems from forcing a 
tag that was designed to display nothing but 
tabular data to act as a layout engine. However, 
there's no point in complaining since it's a fact of 
Web design now. Until CSS is more widely adopted, 
there's nothing to do but try to minimize the pain.  

First let's insert a table by clicking on the table icon 
. Make a 5-column, 4-row table that is 580 pixels 

wide. You should get a Properties palette that looks 
like this: 

 

As with most Dreamweaver Properties palettes, the 
UI is focused on the alteration of tag attributes. The 
table properties, however, contain some extra tools 
to help you manipulate a complex table layout. The 
Table palette, and its tools concentrate on the 
attributes that affect the whole table; e.g., the 
Table tag.  

These two buttons toggle the size of the 
table between a size in pixels and a size 
representing percentage of browser width. If you 
define your table width as a percentage, its width 



will stretch or contract 
depending on the current size 
of your document window in 
Dreamweaver (and, later, your 
browser window). The other 
tool available in this view 
offers you the ability to clear 
either table width or table 

height . This is 
especially useful after you 
mess up a table by dragging it 
around with your cursor. 
Experiment with holding the 

cursor over any of the column or row indicators, 
dragging it around to get the dimensions you want, 
and then clearing everything using the Properties 
palette. Fun, no? (Especially if you've ever had to 
do this by hand.)  

To manipulate specific portions of the table, right-
click (option-click on the Mac) inside the table to 
get this menu. From here you can insert or delete 
entire rows and columns. You can also get the 
properties of the cell, column, or row; modify the 
colors of the border or background of the cell; or 
set the alignment of the content of the table.  

You can also control the column and row-span of 
each cell or modify the border alignment and 
background properties, through either the Modify 
menu or the bottom half of the extended Properties 
palette. The big buttons control the cell properties, 
the little buttons expand or contract the span of the 
row or column.  

 

These tools should enable you to construct some 
very complex tables with a minimum of insanity.  

You should also now know how to construct an 
HTML 3.2 page using Dreamweaver, which brings 
us to the end of our first day. This basic knowledge 
is very useful, and it's probably where you'll get the 
most use out of this product. However, there's a lot 
of cutting-edge HTML out there that makes the Web 
interesting and dynamic. And Dreamweaver can 
help you create this advanced stuff, too. Tune in 



Thursday, when we'll explore the wonderful world 
of JavaScript, CSS, and dHTML through the window 
of Dreamweaver.  

Dreamweaver Walk-Through — Lesson 2 

Marking up a Web site with the old GIF and <TABLE> hack may be frustrating, time 
consuming, contrary to the stated goals of HTML, and pure evil, but there's one thing that 
it's got going for it: It works. It works cross-platform, cross-browser, and cross-version on 
90 percent of the browsers that people actually use. It's how Web pages are done. CSS, 
JavaScript, and dHTML are still considered somewhat experimental, so they're mostly 
limited to non- mission-critical sites (if and only if there's a local guru on hand). But thanks 
to an amazing amount of inconsistencies between browsers and their versions, the average 
Web designer just doesn't want to deal with the varied problems presented by these new 
kids on the block. 

Dreamweaver won't solve stylesheets' universal-browser compatibility problem. Cursed 
browsers! However, it does let you author sites that incorporate dHTML and JavaScript 
without knowing a thing about coding or conditionalization. Even if you're an experienced 
coder, Dreamweaver is often better, and easier, than coding by hand. I have much better 
things to worry about than how to conditionalize around two different incompatible versions 
of the "left" and "top" attribute. 

So, let's make stuff zoom around. 

Now would be a good time  to look over the Webmonkey dHTML tutorial. Dreamweaver deals 
with dHTML like other text editors do: You create some DIVs, assign them ID's, position 
them with CSS, and then control them with JavaScript. But let me show you the 
Dreamweaver specifics. We'll start by making some DIVs, assigning stylesheets to them, 
then we'll use JavaScript to make them do something. 

DIVs and Layers 

To create a dHTML page, start with DIVs. DIVs can 
be inserted into your page from the Common 
collection in the Objects palette. Click on the icon 

to insert the DIV. Instead of the standard dialog 
box, your cursor will pop up a marquee-like icon . 
Use it to draw a rectangle on the page. You should 
now have a bold rectangle with grippers and a little 
handle icon. 

 

The Properties palette will display information 
regarding the Layer. Note that when Dreamweaver 



refers to a Layer, it doesn't necessarily mean the 

<LAYER> tag. Dreamweaver considers any 
absolutely positioned element a Layer and will give 
you a little gripper for that object. Anyone who has 
tried cross-platform dHTML before knows that if you 
move beyond positioning DIVs and SPANs you're 
asking for trouble. To help keep things straight, 
some of the Dreamweaver features - such as the 
Timeline - depend on the presence of a named 
Layer on the page. Dreamweaver considers <DIV>, 

<SPAN> , <LAYER> , and <ILAYER> valid Layer 
objects, and you can choose which tag it will use in 
the Preferences (under Layers). To insert HTML into 
the Layer, click inside the Layer and drop it in, just 
as you would in a document. 

 

To edit the Layer itself, click on its gripper. This 
will call up the Layer UI in the Properties palette. 
From here, you can set the style properties of the 
Layer for all selectors, which will work in both 
Netscape and Internet Explorer. The first attribute 
is set by default: The ID will be labeled with the 
Layer number that you inserted into the document. 
You can replace a more mnemonic name. (But be 
careful! Giving it a reserved name in JavaScript, 
such as "this", will cause both Dreamweaver and 
your browser to go nutzoid.) This name will appear 
in any of the interfaces that reference Layers. Other 
attributes in the Properties palette allow you to 
position the Layer and modify its size.  

 

This is the dHTML "safe" zone. These attributes work 
consistently on DIVs in CSS and - in the case of 
left, top, z-index, and visibility - can be scripted 
with JavaScript. But if you've read my dHTML 
tutorial, you'll know that this can be a chore.  

Play around with the position and size of your 
Layer, either by setting the coordinates in the 



palette or grabbing it by the 
gripper and moving it 
around. Resize the Layer 
with any of the handles on 
the Layer border . The 
other two safe, scriptable 
style selectors are 
accessible through the 
Layers palette. From the 
Window Menu, select Layers 
(or just hit F11 to pop it 
open). 

This palette gives you easy 
access to your Layers - just click on their names. 
You might have noticed that every time you insert a 
Layer you get a little yellow "invisibles" icon in 
your document. These icons allow you to select 
elements that have no visual representation on the 
screen. However, I find these icons take up too 
much space in my document flow, so I usually turn 
them off: In the View menu, it's Invisible Elements, 
or hit C-Shift-I. And leave all my Layer selecting to 
the Layer palette. Any currently selected Layer 
becomes visible and appears at the top of the z-
index. 

 

There are some problems with the selectors in the 
Layer palette. For instance, set a Layer's 
background color in Dreamweaver, and it will look 
exactly as it should in Internet Explorer. But in 
Netscape the color will appear only behind the text 
or images in that Layer. 

 
Layer in 

Dreamweaver 

 

 
Layer in Internet 

Explorer 4.0 

 

 
Layer in 

Netscape 4.0 

Dreamweaver sticks very much to the Web 
standards. It writes HTML and CSS as close as it 
can to the spec. But not all the browsers fully 
support CSS. Even though you can set the 



you will get the invalid rendering shown above. To 
fix this behavior, you need to implement the non-
standard CSS fix. Netscape 4.0 looks for a style 
rule layer-background-color to actually fill out the 
color of the Layer. Unfortunately, Dreamweaver 1.2 
does not have an interface for this selector, so 
you'll have to go to the text window or your text 
editor to add this work-around. 

Again, you will notice that this still doesn't solve the 
problem of the background color. The background 
color will only span the width of the longest text 
line or image. Fixing this problem means delving 
into stylesheets. Luckily, Dreamweaver does have a 
complete interface for this.  

Launch the St yle palette through the window menu 
(or by hitting F7 or by clicking on the icon in any 
of the launchers). And now let's take a tour through 
Dreamweaver's stylesheets functions. 

Stylesheets 

The Dreamweaver Style palette has the unfortunate tendency of hiding most of its functions 
behind a number of dialog boxes. Thankfully, there are shortcuts around this. 

To create a new style, or modify an existing one, click on the Style Sheet button in the Style 
palette to launch the Edit Styles dialog. Add and modify styles for your document (if you 
aren't familiar with cascading stylesheets, you really should read Mulder's stylesheets 
tutorial). Like HTML, Dreamweaver does nothing but parse the CSS rules and render them 
appropriately. Since there are vast discrepancies between the way the two main browsers 
render CSS, much of Dreamweaver's interpretation can only be described as a best guess. 
The program tends to lean toward the CSS interpretation found in Internet Explorer 4.0, but 
it's unable to render some of the valid CSS selectors - background-attachment , for example 
- and it does nothing with the extensions to CSS (though there is a UI to set these). 

When generating a new style, you can create a class, modify the style of an existing tag, or 
"use a CSS selector," which lumps together pseudo-classes (A:link) and ID references 
(#myID). Since we still need to define a border to give our DIVs a background color in 
Netscape, let's redefine DIVs to turn on the border fix (border: 1px none color). Go to the 
style editor, and create a new style. Choose Redefine HTML tag, and select DIV. You now 
have a list of categories: type, background, block, box, border, list, positioning, and 
extensions. Each of these controls a grouping of style selectors. 

type  
font-family, font-size, font-style, line-height, font-weight, font-variant, text-
transform, text -decoration, color  

background  
background-attachment, background-color, background-image, background-repeat, 
background-position  

block  



letter-spacing, text-align, text-indent, vertical-align, word-spacing, white-space  
box  

clear, float, height, width, margin, padding  
border  

border-color, border-style, border-width  
list  

list-style-position, list-style-image, list -style-type  
positioning  

overflow, position, visibility, visibility, z-index, height, width, left, top, clip  
extensions  

cursor, filter  
To complete our background bug fix, go into the style editor and add a border width of 1px 
(note that Dreamweaver will warn you if you enter an apparently invalid value for the 
selector), style of none, and a color of your choice. There should now be a style rule in the 
head that looks a little something like this: 

div { border: red; border-style: none; border -top-width: 1px; border-right -width: 1px; 

border-bottom-width: 1px; border -left-width: 1px} 

Now the background color issue is finally solved. But that's quite a lot of text for a small, 
simple rule. Something like border: 1px red none would be far more manageable. To 
compact the rule, go to Preferences. There you can use a shorthand expression for certain 
properties by clicking on them, deleting the rule, and then re-entering it. 
There are a number of ways to place a style on an element. You could place the cursor 
within the tag and select the desired class from the Style palette (if you don't see any style 
classes in the palette, then you might want to create one), and that section will take on that 
style class. You can also apply a style to a tag by selecting the Tak from the bottom left of 
the screen to get a listing of all the tags that currently contain the current position. Click on 
a tag to select it and all of its content. Or right-click (option-click if you are on a Mac) on a 
tag and then set the Class or ID of the tag. 

 
Another way to apply a style to a tag is by highlighting some text and clicking on a class in 

the Style palette. This will surround the selection with <span> tags set to your selected class. 
All that's missing is the final ingredient of the dHTML devil's brew: JavaScript. 

JavaScript 

To create dynamic or interactive content on a Web page, you have two choices. You can 
build interactivity into the server with some kind of server-side script  or database 
interaction, or you can program it to run in the client's browser with JavaScript. Production 
and design types are often seduced by JavaScript's accessibility (right there in the Web 
page) and all the interesting interactivity it allows: Generate dynamic content! Check for 
plug-ins! Open windows! Validate forms! And - lest we forget - control all aspects of 
dynamic HTML! 



The problem with JavaScript has always been that, while people love to use it on their 
pages, no one's into writing it. JavaScript - billed as easier to write than a "real" language - 
is still a programming language, and not everyone has the desire, or turn of mind, to deal 
with all those if-then statements. And most people don't even want to do anything all that 
fancy, such as change an image on a rollover, open a new window, scan for plug-ins, 
change the status bar, pop up messages, and that sort of thing. DHTML may require more 
complex JavaScripting (which could become more of an issue as it becomes more popular), 
but mostly the practical use of JavaScript involves simply moving around DIVs and changing 
visibility. And these tasks are easily accomplished in Dreamweaver. 

 

Dreamweaver uses behaviors and actions to insert JavaScript into the page. To open the 
Behavior palette, click on the icon (or select it from the Window menu or hit F8). Then 
place the cursor inside a tag that can take a number of events, such as an Anchor tag. Click 
the Add Behavior button to get a listing of all the events that are possible for that tag. 
Right next to the button, you'll find a menu of browsers. From there you can select the level 
of browser you are targeting. Different browsers can accommodate different events on the 
tags. An example: Only the mouseover event is available on the Anchor tag in Netscape 2.0, 
while, with Internet Explorer 4.0, almost every event is available to every tag. Let's select 
the Onmouseover event. 

Now, go to the other half of the Behavior palette to insert the action, which is actually a 
JavaScript function. By clicking the Add Action button, you get a list of actions/functions. 
Some actions depend on whether certain HTML elements are in the pages (i.e., you can't 
put the Imageswap function on your page unless you have an image on your page). After 
you insert the appropriate action, you can edit the values that you inserted by placing the 
cursor in the HTML element, clicking on the event that you want to have trigger the action, 
and then double-clicking on the action that you want to modify.  

Note: All this can be a bit confusing, especially since it's sometimes hard to relocate actions 
that you inserted into the page. Like with many things in Dreamweaver, you have to select 
the right element to get the specific menu or palette you seek. Be prepared to do some 
clicking around, especially in the beginning.  

In the source, all the actions are located in the appropriate event tag (such as Onmouseover 
or Onclick). Set up a rollover with Dreamweaver, and here's what you end up with in your 
Image tag: 

<a href="#" onMouseOver="MM_swapImage('document.myImage', 

'document.myImage','/webmonkey/98/27/stuff3a/size.gif')"> 
<img src="/webmonkey/98/27/stuff3a/image.gif"></a> 



Which is pretty similar to what you'd have if you generated your own code.  

Notice that if you choose the Swap Image action for an image, then choose an event to bind 
it to, there are actions at the top of the list and even more below the separator listed in 
parentheses. The actions not in parentheses are those that are available for the HTML 
object - such as Onload for an image. Events that are in parentheses are available only after 
you modify the HTML source, usually by putting an anchor around the tag. Fear not: If it's 
necessary to alter the source, Dreamweaver will give you an alert before doing so. 

Dreamweaver ships with many JavaScript functions - image-swapping functions, window 
openers, and document redirects - as well as with a way to alter the visibility of layers. But 
one of the most noticeable aspects of dHTML - making layers fly around - doesn't seem to 
have an action associated with it. That's because Dreamweaver has a whole palette 
dedicated to that task: the Timeline.  

The Timeline 

Click on the icon in the Launcher and select 
Timeline from the Window Menu (or press F9). If 
you're at all familiar with Macromedia's Director or 
Flash, you should have no trouble recognizing this 
feature.  

 

In many respects, the Dreamweaver Timeline is similar to those 
found in these other programs: You have a behavior channel where 
you can launch actions and other channels where you place objects. 
Unlike Director or Flash, however, the Dreamweaver Timeline is just 
a complex and large chunk of JavaScript, which is the only way to 
preview interactions that happen over time without sending the 
page to the browser. 

Only layers and images can be added to the Dreamweaver Timeline, 
and only layers can be positioned. Create a layer, then drag it from 
the document window to the Timeline palette. The object should 
now appear on the Timeline as a symbol: a line bookended by two 
circles. 



 

The circles represent keyframes, which indicate the times when 
something actually happens to the object. Dreamweaver can 
"tween" images between these two keyframes (i.e., create a series 
of images that gradually change from the first image into the 
second). You can change values for the Layer at each keyframe (but 
to maintain cross-browser compatibility, only change the left, top, 
or visibility of a Layer. Although Dreamweaver allows you to do so, 
don't alter the width of a Layer because that change is only visible 
in Internet Explorer. To add more points of interaction, click on the 
frame you want to alter, then right-click (on Macs, option-click) the 
selected cell. From here you can control the Timeline operations. 
You can add another keyframe or remove it, as well as add and 
remove objects (or even more Timelines, which I cover below). Try 
moving your object. Now select the Timeline object and you should 
see the movement articulated by the path made by the upper left 
corner of the image. 

 

Where you choose to modify a Layer can make a difference. If you 
select and modify it completely outside the Timeline, the object will 
have those properties on the page at load time. If you highlight the 
entire object in the Timeline by clicking on a non-keyframe portion, 
the image will be modified for the entire duration of the Timeline. 
Select a Keyframe in the Timeline, and it is modified for that frame 
only, but earlier frames will "tween" into it. 

To play a Timeline, you need to call it from an event with a Play 
Timeline action. You can also use an action to stop Timelines or go 
to a specific point in a Timeline. The most common uses of this - 
playing a Timeline at load and looping a Timeline - are built into the 
Timeline palette as the Autoplay and Loop checkboxes, which can 
be set and unset for each Timeline group. 

Not only can you layer objects in the Timeline, but you can also 
have multiple Timelines playing on your page. Use the contextual 
menu (right - or option-click) to add a new Timeline. For this 
alternate Timeline, have your images do something entirely 
different. In the last cell of your first Timeline, select the new 
Timeline with the Play Timeline action. You can build up complex 
behaviors by layering Timelines like this. To see a huge number of 
Timelines layered on top of one another, check out this screensaver 
I created for Seybold. (WARNING! Some browsers may not be able 



to display the screensaver correctly due to its dynamic content.) 

This screensaver also provides a good example of the kind of 
problems that dHTML has with its use of generic, flexible JavaScript 
code: the HTML and JavaScript alone add up to 56 KB, and that's 
without images. Since the Timeline records all the movement 
information, you get huge blocks of code that look something like 
this: 

document.MM_Time[18][0].values[0] = new Array(592,566, 

541,516,495,477,462,453,440,427,406,389,371,351,332,316, 

302,317,327,326,306,310,316,300,287,272,257,241,224,206, 

188,169,151,133,116,100,90,84,82,81,81,82,82,83,83,83, 

82,79,71,59,49,40,28,11,-180,648,687,655,623,592); 

This represents a path that an object travels, along with the values 
of the properties of one, and only one, layer (in this case, the left of 
the object). The more cells you have, the more information your 
Timeline stores and the bigger your page. 
Fiddle around with the Timeline, and create an animation. You can 
also tinker with the source of my screensaver by loading the page 
into Dreamweaver with the Timeline information. 
As you play with Dreamweaver, keep your eyes peeled and your 
mind open for the kinds of shortcuts or special features you wish 
the program had, because we are going to customize the puppy 
next.  

Customize Is Always Right 

Dreamweaver ships with most objects and actions that you might need. But it can't 
anticipate everything. I like to produce generative art sites. And the kind of tool that will 
help me do so isn't at all useful for the person creating a corporate intranet site; someone 
who needs a tool that, say, helps design better tables. Dreamweaver takes this into account 
by allowing you to customize both your actions and your objects as you see fit - since these 
are really just HTML files with JavaScript. 

Go to the folder where you installed Dreamweaver, and open up the Configuration folder. 
From here you will see a listing of folders such as Behaviors, Objects, Templates, and 
Browser Profiles. All these folders contain HTM files that determine your Dreamweaver 
configuration. The Objects folder contains the sub-folders Common, Forms, and Invisibles. 
Sound familiar? If you want to regroup your existing objects - say, you never use plug-ins, 
but you do use forms all the time - then take the form elements, place them in the Common 
directory, then create a folder called Plug-ins, and drop in all the plug-in objects. Each 
object consists of an HTM file and a GIF icon, so remember to get them both.  

Ta-Dah! You've just customized your workspace. 

The Behaviors work in much the same way. There are two folders, Actions and Events. The 
Events folder contains a list that determines what browsers you target, as well as what 



events are available in the browsers and on what tags. If a sizable portion of your audience 
uses Opera, you could add this to the list. The Actions folder is where the actual JavaScript 
code is generated, in response to the input of the dialog. This is where you would place any 
actions that you might download off the Web, for instance, from Webmonkey's Code 
Library. 

You can even create your own specific actions and objects. The best way to get started is to 
just begin changing some of the values of existing objects or behaviors to better suit your 
needs. But before you go crazy, make sure you've made a copy of the originals, which is 
always a good idea. If you want to move on to creating your own custom behaviors, check 
out Macromedia's behavior-development kit. 

It's been a long-standing dream of mine (well, OK, I got the idea from a book) to find or 
create a tool that will put me out of a job. See, I've always wanted to be a rodeo clown. 
GNU Emacs and their volumes of lisp code got close, but are still no cigar. Dreamweaver is 
also an improvement, but it leaves enough to do by hand that I still pull down a paycheck. 
At least with Dreamweaver, I'll never have to implement another image rollover for anyone 
ever again. Which is certainly something. 

Dreamweaver Extensions 
http://webdesign.about.com/cs/dreamweaverext/index.htm   
Free objects, behaviors, and commands for Macromedia Dreamweaver.  

Dreamweaver Dabbling 
Free extensions - jump menu, pop window, swapper, and miscellaneous commands. From 
Hal Pawluk.  

Dreamweaver Depot Commands 
More than forty command extensions. From Andrew Wooldridge.  

Dreamweaver Fever 
A dozen or so useful objects, commands, behaviors, and inspectors. From Drew McLellan.  

Extensions Database 
A searchable database of Dreamweaver objects, behaviors, and commands. Compiled by 
the author of the book Dreamweaver Bible.  

Macromedia Exchange 
Macromedia's database of Dreamweaver extensions. Each extension has its own page that 
includes the extension, a short description, user reviews, and a discussion group where you 
can post questions and get support for an extension.  

Macromedia Templates 
Templates you can use as a starting point for projects or comps.  

Massimo's Corner 
Dozens of useful objects, inspectors, and behaviors, along with a few tips and tricks. From 
Massimo Foti.  



Pretty Lady  
DHTML interfaces, commands, objects, and behaviors. From Eddie Traversa.  

Project Seven Extensions 
Free commands and actions to breath life into your Dreamweaver pages. From Al Sparber.  

Project Seven Design Packs 
More than templates -- everything necessary for users of Dreamweaver and Fireworks to 
produce professional customized Web sites in just a few hours. Available for online 
purchase.  

Top 5 Dreamweaver Extensions 
Builder.com looks at the hundreds of Dreamweaver extensions available at Macromedia's 
new Exchange site and picks the best five.  

Webmonkey Code Library 
Dreamweaver extensions for using cookies, animating layers, dynamically scaling fonts, and 
enabling XSSI in the WYSIWYG environment.  

Yaromat 
A wide variety of useful behaviors, inspectors, commands, and objects. From Jaro von 
Flocken.  

 

 
 
 

Tag Tips 
 
Go ahead: hand code if you want to--Macromedia won't mind. The company has 
created Dreamweaver knowing that professional Web builders want to get their hands 
into the guts of their sites. So unlike some other Wysiwyg editors that may deter you 
from hand coding, you have easy access to the HTML in Dreamweaver. Use these tag 
tips to take advantage of this feature.  

Hand Code If You Want 

To get into the code, you need to launch the HTML Inspector: 

If you want to work in the HTML Inspector and save on mouse-clicks, the best way to 
open the HTML Inspector is to use Ctrl+Tab. This will open the HTML Inspector as 
the active window so that you can immediately type in it without having to change the 
focus first. You can also use this command to toggle between the HTML Inspector and 
Document window.  

As you work in the HTML Inspector, you can click back to the Document window to see 
your changes. Alternatively, you can work in the Document window and see your 
changes immediately take effect in the HTML Inspector (without switching windows). 



Although several Wywiwyg editors now let you view the layout view and the source 
code simultaneously, Dreamweaver is one of the few that allows you to work in both at 
the same time. (It should be noted, however, that closing the HTML Inspector will 
improve the overall performance of Dreamweaver.)  

Use a Code -Based Editor 

The HTML Inspector is not really what you'd consider a code-based powerhouse. But 
that's OK, because the Macromedia team realizes there are better code-based editors 
out there--and even provides one for you.  

Dreamweaver 2.0 is bundled with HomeSite 4.0 for Windows or BBEdit 5.0 for Mac 
(except the educational, upgrade, and ESD versions). To work with one of these editors, 
simply launch the HTML Inspector and click the External Editor button. (You can also 
select Edit/Launch External Editor from the Document window, or use Alt+E, D.) If you 
haven't previously specified which external editor you want to use, the Preferences 
dialog box will appear. Make sure External Editors is highlighted in the left column, and 
then type or browse for the program you want to use. Click OK to launch the editor. The 
next time you launch an external editor, the code-based editor of your choice will open.  

Eradicate Unnecessary Tags 
Editing a complex site can be difficult, and you may have an empty set of tags dangling 
somewhere in your document. These types of errors can easily occur when you're 
moving objects around in your document, but Dreamweaver 2.0 lets you eradicate these 
code errors easily with its Clean Up HTML feature.  

This feature is not an HTML validator by any means, but it lets you tighten up your code 
by eliminating such errors as a stray end tag. Choose Commands/Clean Up HTML from 
the menu bar. In the dialog box that appears, you have several options for cleaning up 
your HTML:  

Remove Empty Tags 

If, for some reason, you have tags that don't contain content, you'll want to get rid of 
them. You can select this option, which is checked by default, and Dreamweaver will 
eliminate all the empty tags. For example, the second set of italic tags in this code will 
be deleted:  

Ponch was <I>way</I> cooler than Jon.<I></I>  

Remove Redundant Nested Tags 

In case you got a little carried away with coding and inserted some extra tags along the 
way, Dreamweaver with delete them with this option (selected by default). For example, 
the nested italic tags in the following code will be deleted (so make sure the nested tags 
are the ones you really want to eliminate before choosing this option!):  



<I>Ponch was <I>way</I> cooler than Jon.</I>  

Remove Non-Dreamweaver HTML Comments 

This option deletes all of the comments in the document that were not inserted 
automatically by Dreamweaver. For instance, <!--Created by Kim Wimpsett, 4/6/99--> 
would be deleted because it was entered manually, but <!-- #BeginLibraryItem 
"/Library/library1.lbi" --> would be retained since it's a Dreamweaver comment (used to 
specify a library item).  

Remove Dreamweaver HTML Comments 

This option allows you to eliminate all of the comments that Dreamweaver has inserted 
into your code. However, Dreamweaver only inserts comments into documents using 
library items, templates, or tracing images to signal the documents as such. Removing 
these comments turns template-based documents into regular HTML documents, library 
items into normal HTML code, and removes tracing images. If you remove these 
comments, you won't be able to automatically update all of your pages that contain the 
element, so you'll want to be careful when selecting this option.  

Remove Specific Tag(s) 

With this option you can delete all instances of a specific tag with one click of the OK 
button. Say you had a change of heart and decide you don't like all those <BLINK> tags 
you used when your first learned HTML. Just check the box, enter blink, and click OK. 
You can even delete several tags at once by separating them with commas. Don't 
include the tag's brackets, and don't worry about the case: blink,FONT works just fine, 
for example.  

Combine Nested <FONT> Tags When Possible 

This option combines <FONT> tags so that something like this:  

But I had a crush on <FONT color="red"><FONT size="+1">Sgt. 
Getraer<FONT><FONT>!   

would be more lean and mean, like this:  

But I had a crush on <FONT color="red" size="+1">Sgt. Getraer<FONT>!  

When you've selected which options you want to use to clean up your HTML, you can 
decide if you want a notice of what was changed by selecting Show log on 
completion . You might like to know the number of empty tags you had in your 
document, for example, so you can watch out for those in the future. The log is not very 
informative, but JavaScript experts can open the file Clean Up HTML.js in a text editor 
(the default location is \Dreamweaver 2\Configuration\Commands\) and customize the 



report.  
 

Format Your Code With One Click  

Web builders can be picky about their source code. You know how you are--you must 
indent subsections four spaces instead of five. You lie awake at night thinking about 
how someone mixed their cases (gasp!). Neat code is a good habit to pick up and it 
usually saves you time later when you're looking for a specific piece of code. But if you 
share coding responsibilities with co-workers, you may find that not everyone shares 
your tidy coding habits.  

With Dreamweaver, you can now get a good night's rest even if some tags are 
capitalized and others are lowercase. Just use the Commands/Apply Source Formatting 
option to format the code exactly how you want it to look. But first you must define how 
you would like your code formatted.  

Select Edit/Preferences from the menu bar (Alt+E, S in Windows or Command+U for 
Mac), highlight HTML Format in the left column, and you'll see the wide variety of 
options you can specify: the size of indents, the case of tags and attributes, and more. 
Once you've chosen your personal formatting preferences, click OK.  

Now if someone was a little sloppy in their coding, you can just select Commands/Apply 
Source Formatting-your own formatting options will be applied to the existing code. 
Furthermore, every time you create a new document, your formatting techniques will 
already be in place. Ahh, no more sleepless nights….  

For Advanced Web Builders 

Advanced Dreamweaver users can have even more control over code formatting on a 
tag-by-tag basis. Quit Dreamweaver, and open the SourceFormat.profile file (located in 
Dreamweaver\Configuration) in a text editor. This can be a little confusing, but 
Macromedia offers some instructions . When you're finished editing the file, save it and 
restart Dreamweaver to see your formatting take effect. 

Search and Replace Globally 

The advanced search capabilities of Dreamweaver 2.0 will make experienced Web 
builders starry-eyed. You might even want to switch from other tools to Dreamweaver 
just for this powerful feature.  

You can launch the search-and-replace function from within the Document window 
using Edit/Replace (Alt+E, E for Windows or Command+H for Mac) or from within the 
HTML Inspector (right-click for Windows or Ctrl+click on the Mac, and then choose 
Replace for Windows from the pop-up menu). You'll be able to search the current 
document, the current site, or a selected folder. You can also launch this function from 



within the Site window (by using the same commands). From here, you'll be able to 
search selected files, the current site, or a selected folder.  

The site-wide option is not the only feature that makes the search-and-replace so 
impressive. You also have a lot of leeway as to what you can search for:  

• You can search for regular text, which ignores any HTML tags that interrupts the 
text string. For instance, searching for "CNET Builder.com" would find both 

"CNET Builder.com" and "CNET <a 

href="http://www.builder.com/">Builder.com</a>".  
• The HTML Source  option lets you search for text that may appear within tags, as 

well. For instance, this is the option you would use if you were looking for "CNET 

Builder.com" within this tag: <IMG src="cnetlogo.gif" alt="CNET Builder.com 

logo">.  
• With the text (advanced) option, you have the choice of searching for specific 

text inside or outside of a tag. And you can limit your search by using the plus or 
minus buttons to use specific tags.  

• You can search for specific tags, attributes, and values with the powerful tag 

option. For instance, you could find all the <TABLE> tags in the entire site that 
have the height attribute as 100 percent and change them, delete them, or add 
text within them .  

You also have the option of being case-sensitive in your search, ignoring whitespace 
differences, and using regular expressions. That's all there is to it. By choosing a few 
options in an easy-to-use dialog box, you have the most powerful search-and-replace 
feature to date in a Wysiwyg editor. 
 

Add <BR> and &nbsp; Quickly 
 
Spacing your text just right is important to most Web designers and graphic artists. 
Keyboard shortcuts for frequently used tasks exist in most Wysiwyg HTML editors to 
save Web builders' time, and Dreamweaver is no exception. It offers two spacing 
shortcuts that will save you time.  

When you want a non-breaking space --one that keeps the two words around it on the 
same line--who can remember that convoluted character code? This tip will let you 

insert the &nbsp; code into the HTML easily. For Windows, just position the cursor 
where you want and select Ctrl+Shift+Spacebar. If you use a Mac, it's even simpler: use 
Option+spacebar.  

As for vertical space, sometimes a paragraph break is just too much space. For those 

who know HTML, the line-break tag is a lifesaver in these situations. To enter <BR> 



quickly in Dreamweaver, just use Shift+Return. Those familiar with the soft Return in 
Microsoft Word will find this shortcut to be second nature.  

 
Tutorial: Creating Flash in Dreamweaver 4 
How to create Flash buttons and text in Macromedia Dreamweaver 4 
http://webdesign.about.com/library/weekly/aa072501b.htm 
 

You can create editable vector graphics directly in Dreamweaver 4 with the Macromedia 
Flash Buttons and Flash Text features.  

Creating Flash Buttons  

Dreamweaver comes with a variety of button styles (including navigation tabs, playback 
controls, and ecommerce buttons), or you can create your own, or you can download free 
styles from the Macromedia Exchange.  

1.  From the Dreamweaver menu bar, select: Insert > Interactive Images > Flash Button.  

2.  The Insert Flash Button window will open. Select a button style, text, font, font size, link, 
target window, background color, and file name. The preview window displays each button 
as you select it.  

 

3.  Click Apply to view the button on your page. Make desired changes, clicking Apply to see 
the results.  



4.  Click OK to add the Flash button to your page.  

4. Preview the page in your browser to see the button in action.  

Here's how the above button style will look (move your mouse over the button to see how it 
works):  

 

   

 

Creating Flash Text   

1.  From the Dreamweaver menu bar, select: Insert > Interactive Images > Flash Text.  

2.  The Insert Flash Text window will open. Select font, font attributes and colors; type 
desired text in the available box; fill in link, target, background color, and save as fields.  

 

3.  Click Apply to view the text on your page. Make desired changes, clicking Apply to see 
the results.  

4.  Click OK to add the Flash text to your page.  

4. Preview the page in your browser to see it in action.  

Here's an example of how the Flash text will look (move your mouse over the text):  



Here's how your Flash text will look:   

 

   

 

Be sure to use the Flash Button and Text features wisely to avoid slow-loading pages. 
Remember, too, that your site visitor's will need to have the Flash plug-in in order to view 
the Flash animations.   


